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 Présentation du HFSS 

Le HFSS (High Frequency Structor Simulator)  est un logiciel de simulation des structures 

électromagnétiques (EM) 3D travaillants en hautes fréquences comme les antennes, les 

composants RF hyperfréquences, les connecteurs, les filtres, les circuits intégrés, … etc. Avec 

son interface 3D, le HFSS permet aux concepteurs scientifiques et industriels, de modéliser leurs 

structures d’une façon précise et détaillée, et  même d’importer la géométrie CAO  pour pouvoir 

visualiser les différents paramètres de la structure souhaitée dans les différents domaines de la 

recherche ; mécanique, physique, électronique et télécommunication. Dans son guide [1] l’auteur 

explique en détails les différentes fonctionnalités et caractéristiques de cet immense simulateur. 

Le HFSS est muni des méthodes et techniques avancées pour la résolution des problèmes et des 

complications techniques rencontrés dans le monde professionnel. Les scientifiques et les 

industriels peuvent alors gagner du temps et du coût pour résoudre les problèmes et faire ainsi 

améliorer et même inventer des conceptions EM. 

 

 Création et conception des antennes par le HFSS 

Le HFSS offre la possibilité de créer des descriptions complètes et précises des antennes de 

télécommunication. Et de voir toutes les caractéristiques de ces antennes dans un environnement 

conditionné afin de se rapprocher à l’environnement EM réel. Avec le HFSS, nous pouvons aussi 

visualiser les différentes caractéristiques des antennes conçues comme les paramètres S, Z, Y, le 

champ E, le champ H, le gain, la directivité, le rayonnement et autres relativement aux 

paramètres d’entrée de la conception réalisée. Ces visualisations peuvent être représentées dans 

des référentielles 2D ou 3D. 

 

 Objectif du TP1 : Nous résumons les objectifs de ce TP dans les points suivants : 

 Découvrir et utiliser l’environnement HFSS, 

 Concevoir des différentes structures des antennes, 

 Visualiser les différentes caractéristiques et performances des antennes conçues, et 

 Tirer un bilan sur l’usage et l’efficacité de chaque antenne à travers leurs caractéristiques. 
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 Prérequis nécessaires 

Pour le bon déroulement des séances du TP1, l’étudiant doit : 

 connaitre les notions fondamentales sur l’antenne Dipôle  et l’antenne monopole, 

 Maitriser les différentes caractéristiques de ces antennes, 

 Savoir utiliser le simulateur HFSS. 

 

 Outils nécessaires 

 Un microordinateur, RAM (4Go), 

 Windows 7 x64 (minimum).                Disponibles au laboratoire. 

 Logiciel HFSS v15 installé, 

 Mesures conformes de l’antenne doublet de Hertz,         Disponibles sur le support. 

 Clé USB pour sauvegarder les résultats obtenus,  

 Papiers millimétriques,             fournit par l’étudiant. 

 Outils de dessin et de mesures (crayon, règle, gomme,…). 

 

 Durée nécessaire :   Le TP1 nécessite 03 séances (3x1h30). 

 

 

 Rapport du TP : A l’issue du TP, chaque équipe (binôme) est demandée de déposer durant la 

semaine, un rapport contenant les réponses demandées. 
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Introduction à la simulation par  HFSS 

Etapes de conception et simulations des antennes 

 

 

 Objectif: Dans cette expérience, l’étudiant va découvrir l’environnement HFSS et 

connaitre les étapes nécessaires pour concevoir et faire des simulations sur des 

différentes antennes dans les expériences prochaines.  

 

 Lancement de l’environnement HFSS 

Lancer HFSS à travers son icone placé sur le bureau ou sur le menu démarrer ; la fenêtre ci-

dessous apparait (version 15.0.0 (Build : 2012-10-09)). 

 
 

Fig 1.1 La fenêtre principale du HFSS. 

TP1 : Expérience 1 : 
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Après la création de l’antenne voulue, on peut extraire les caractéristiques générales de 

l’antenne. Vous trouvez ci-après quelques caractéristiques importantes des antennes :  

 Impédance caractéristique 

À l’émission comme à la réception ; l’antenne est considérée comme une charge alimentée 

par une tension Vin en absorbant un courant Iin et et une impédance alors Za = Vin/Iin = Ra +iXa. 

Donc, on peut représenter l’antenne par un circuit électrique (Figure 1.2) ayant cette impédance 

lors des calculs de transfert de la puissance. Tel que la partie réelle est reliée aux champs 

rayonnés et aux pertes joules, et la partie réactive est reliée aux inductions autours de l’antenne.  

Ra

Xa

Vin

Iin

Za =

Ra

CaLa

 

Fig 1.2 Schéma électrique équivalent d’une antenne. 
 

 Adaptation d’impédance 

Pour assurer un transport optimale (sans distorsion) de la puissance depuis l’alimentation 

jusqu’à l’antenne ; nous devons conduire notre circuit à une adaptation d’impédance entre le 

circuit d’alimentation fournissant une puissance Pe ayant une impédance Ze, et l’antenne : Ze=Za. 

 

 Le coefficient de réflexion S11 

Le coefficient de réflexion est le rapport entre l’onde réfléchie et l’onde transmise 
𝑉𝑟

𝑉𝑖
. Ce 

rapport représente la qualité de la transmission, tel qu’à l’adaptation la puissance émise est 

entièrement rayonnée, et l’onde réfléchie devient alors très petite ainsi que le coefficient S11. Il 

est souvent marqué par le symbole 𝜞, tel que 𝑆11 = 20𝑙𝑜𝑔𝛤. La figure 1.3 représente la 

variation du 𝑆11 résulte d’une simulation d’un dipôle de hertz qu’on va le faire dans l’expérience 

prochaine.  
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Fig 1.3 La variation du coefficient S11 en fonction de la fréquence (Dipôle de hertz). 

 

 Fréquence de résonnance Fc 

Est la fréquence avec laquelle l’antenne fonctionne plus efficacement lorsque son impédance 

caractéristique devienne purement active (composante réactive très faible≅ 0). La Fc dépend des 

caractéristiques de l’antenne et de ses dimensions géométriques, et peut être alors calculée à 

partir de son schéma électrique équivalent (circuit RLC) comme suit :  

𝐹𝑐 =  
1

2𝜋√𝐿𝑎𝐶𝑎

 

 Le diagramme de rayonnement dans le plan E 

Est une représentation graphique de la variation de la puissance rayonnée de l’antenne en 

fonction des grandeurs spatiales variables 𝑅 𝑒𝑡 𝜃. Cette présentation est exprimée dans le plan E 

(plan vertical)  suivant les axes (YOZ). 

 

Fig 1.4 Diagramme de rayonnement dans le plan E. 
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 Le diagramme de rayonnement dans le plan H 

Est une représentation graphique de la variation du rayonnement de l’antenne en fonction des 

grandeurs spatiales variables 𝑅 𝑒𝑡 𝜑. Cette présentation est exprimée dans le plan H (plan 

horizontal)  suivant les axes (XOY), comme le cas ci-dessous (Figure 1.5) pour un dipôle de 

hertz. 

 

Fig 1.5 Diagramme de rayonnement dans le plan H. 

 

 L’angle d’ouverture (𝜽−𝟑𝒅𝑩) 

Un paramètre qui décrit le niveau de la directivité de l’antenne par la mesure de la largeur de 

son lobe principal de rayonnement. L’angle d’ouverture est souvent marqué par le symbole 

𝜃−3𝑑𝐵, et qui représente l’espace dans la direction maximale où la grande partie de l’énergie est 

focalisée (la moitié de la puissance maximale). 

 

 La directivité 

Représente la capacité de l’antenne de concentrer l’énergie dans une direction déterminée 

(angle précis). Elle est aussi définit par le rapport entre l’intensité de rayonnement dans une 

direction donnée et l’intensité de rayonnement d’une antenne isotrope.  

𝐷 =
𝑈(𝜃, 𝜑)

𝑈𝑖
 

La directivité d’une antenne peut être aussi évaluée par son diagramme de rayonnement, après 

avoir tracé l’ouverture à -3dB 𝜽−𝟑𝒅𝑩du lobe principal. 
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 Le Gain  

Est un paramètre important des antenne, et qui est en relation directe à la directivité. Tel que, 

si l’antenne est d’une efficacité totale (𝜂 = 1), alors la directivité et le gain sont égaux. En 

réalité, l’antenne présente souvent une direction maximale pour son rayonnement, et le gain peut 

être alors exprimé par la quantité d’énergie délivrée dans une direction par rapport à la quantité 

perdue dans les autres directions. 

  𝐺(𝜃, 𝜑) = 𝜂. 𝐷(𝜃, 𝜑)  

 

 Le diagramme de rayonnement en 3D 

Est une représentation graphique de la variation du rayonnement de l’antenne dans toutes les 

directions spatiales en fonction des grandeurs spatiales variables 𝑅, 𝜃 𝑒𝑡 𝜑. Cette présentation 

est exprimée dans les 03 plans simultanément suivant les axes (OXYZ). La figure ci-dessous 

(figure 1.6) représente un diagramme de rayonnement d’un dipôle de hertz qu’on va le faire dans 

l’expérience prochaine. 

 

Fig 1.6 Diagramme de rayonnement dans l’espace (3D). 
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Simulation de l’antenne 

Dipôle de Hertz 
 

 

Introduction 

Dans cette séance de travaux pratiques, nous allons concevoir une antenne dipôle par le 

simulateur HFSS en utilisant les paramètres donnés ci-dessous.  

 

 L’objectif est de visualiser les différentes caractéristiques et performances de l’antenne 

dipôle. 

 

 Définition 

Le dipôle de Hertz est une antenne de référence largement utilisée en radiocommunication. Il 

est de conception simple de longueur très petite par rapport à la longueur d’onde du lien établie. 

Le dipôle est alimenté en son milieu par un courant variable sinusoïdal qui circule dans le même 

sens dans les deux brins pour créer deux pôles. Ainsi, les champs électromagnétiques créés par 

les deux brins s’additionnent. Le dipôle le plus connu est le dipôle demi-onde alimenté par un 

câble coaxial d’une impédance caractéristique de 75 Ohms (Figure 7). La fréquence de coupure 

peut être ajustée par un ajustement des longueurs des deux brins. 

 

 

Fig 1.7 Dipôle demi-onde. 

 

TP1 : Expérience 2 
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 Domaines d’application 

L’antenne dipôle est très utilisée dans la radiocommunication soit en autonome en conception 

indépendante (seule) ou en composition pour la conception d’une antenne plus compliquée 

comme l’antenne Yagi, boucle, Cornet, réflecteur parabolique et d’autres. Alors, le dipôle est 

souvent utilisé comme une antenne de réception de la télévision terrestre (bande VHF), antenne 

de diffusion-réception FM, antenne de masse fixe en bande UHF pour les mobiles radios. 

 

I. Conception et simulation de l’antenne 

Pour la création et la conception de l’antenne Dipôle de Hertz ; nous allons considérer les valeurs 

et les dimensions suivantes : 

Paramètre Symbole utilisé Valeur 

Longueur d’onde lymda 10mm 

Rayon du dipôle  rad_dip lymda/100 

Rayon du cylindre  rad_mes rad_dip + lymda/4 

Source d’alimentation  gap_feed 0.125mm 

Longueur référence res_len 0.475*lymda 

Longueur du dipôle len-dip (res_len/2)-(gap_feed/2) 

Hauteur du cylindre mes_hi (gap_feed/2)+len_dip+lymda/10 

Table 1.1 Dimensions pour la conception du Dipôle. 

 

 

 Note: Vous gardez ce tableau pour l’utiliser durant la conception et la simulation de l’antenne. 
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II. Conception de l’antenne 

Pour concevoir l’antenne et l’environnement de mesures ; veuillez suivre les étapes 

suivantes : 

1- Dans la barre d’outils, sélectionner File > New, et un nouveau projet apparait dans la fenêtre 

« Project manager », 

2-  Dans la barre d’outils, sélectionner Tools > Options > General options > Default Units > 

Length :  « mm », 

3- Dans la barre d’outils, sélectionner Tools > Options > General options > Default Units > 

Frequency :  « GHz », 

4- Dans la barre d’outils, sélectionner Project > Insert HFSS design, 

5- Dans la barre d’outils, sélectionner Project > Save as : Dipole-antenna, 

6- Dans la barre d’outils, sélectionner HFSS > Design Properties > add : ajouter tous les 

paramètres d’entrée donnés dans le tableau mentionné ci-dessus, (vous allez avoir cette 

fenêtre). Remarque :  ‘unit type’ de tous les paramètres est ‘Length’ 

 

7-  Pour tracer la première partie de l’antenne, on trace un cylindre. Pour 

cela dans la barre d’outils, appuyer sur « Draw cylindre », et dessiner le 

cylindre. Une fenêtre du cylindre apparait à gauche. 

8- Dans cette fenêtre, fait un double clic sur « Cylinder1», et modifier le nom et le matériel : > 

Name : dip, et  

                 > Material > edit > pec. 

9- Dans la même fenêtre : > double clic sur « CreateCylinder», et mettre les dimensions 

suivantes : 

> Centre : 0 , 0 , gap_feed/2, 
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> Radius : rad_dip, 

> Height : len_dip, 

10- Pour compléter l’antenne, on fait :  > clic droit sur « dip » > Edit > Duplicate > Axis : X 

> Angle : 180°. 

11- Maintenant, on trace la source d’alimentation (Fed), pour cela : dans la barre d’outils, 

appuyer sur « Draw ractangle ». Dessiner le rectangle. 

12- Dans la fenêtre à gauche, > double clic sur « Rectangle1», et modifier le nom : > Name : 

Fed. 

13- Dans la même fenêtre : > double clic sur « Createrectangle», et 

mettre les dimensions suivantes : 

> Position : 0mm ,-rad_dip ,-gap_fed/2 

> Axis : X, 

> Y size : rad_dip*2, 

> Z size : gap_feed, 

14- Pour spécifier le type d’excitation de l’alimentation : > clic droit sur « Fed » > Assign 

Exitation > Lumped Port > Name :1 > Clic Next > Integration line > New line > Defined > 

Clic Next. 

 

III. Mesures des caractéristiques 

Pour tracer les mesures sur les performances de l’antenne, on doit définir la surface où on veut 

prendre les mesures. On va choisir un cylindre plus grand que l’antenne où la mesure sera prise 

au niveau de sa surface. Seulement, ce cylindre de mesure doit se placer à une distance suffisante 

par rapport à l’antenne pour assurer la mesure dans le champ lointain. Pour cela, on suit les 

étapes suivantes : 

1- Dans la barre d’outils, appuyer sur « Draw cylindre », et dessiner le cylindre. Il va apparaitre 

dans la fenêtre à gauche. 

2- double clic sur « Cylinder1» > Name : Mesure_limits, 

> Color : Vert, 

> Transparent : 0.7. 

3- Dans la même fenêtre : > double clic sur « CreateCylinder», avec : 

> Centre : 0 , 0 , - mes_hi, 

> Axis : Z, 
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> Radius : rad_rad, 

> Height : rad_hi*2, 

4- Pour définir le cylindre comme une surface de mesure : > clic droit sur « Mesure_limits » > 

Assign Boundary > Radiation. 

 

Fig 1.8 Antenne et l’environnement de mesure. 

 

5- Dans la fenêtre la plus à gauche (Project manager window) : > clic droit sur « Analysis » > 

Add solution setup : 

> Solution frequency : f=c/lymda = 29,9792 GHz, 

> Maximum number of passes : 20, 

6- Dans la fenêtre la plus à gauche (Project manager window) : >  Analysis» > Setup1 > add 

frequency sweep : 

> Sweep Type : Fast, 

> Frequency setup: > Type : LinearStep, 

>  Start : 25 GHz, 

> Stop : 35 GHz, 

> Step : 1000, 

 

7- Pour vérifier que la simulation est complète et la programmation et les données 

introduises sont justes, on fait : Dans la barre d’outils, appuyer sur Validate. Si la 

fenêtre ne montre pas des erreurs, alors la conception est complète. 
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Fig 1.9 Structure créée valide (ne porte pas d’erreurs). 

 

  

IV. La simulation des performances (Résultats) 

 
1- Dans la barre d’outils, cliquer sur « Analyze all » .   

 

 Si la conception ne porte pas des erreurs et si les données introduises 

sont valides, alors une fenêtre en bas affiche le message « Normal Completion of simulation». 

Comme le montre la figure ci-dessous. 

 

Fig 1.10 Simulation vérifiée et validée. 

 

2- Dans la fenêtre la plus à gauche (Project manager window) : >  clic droit sur Results > 

Creat Model Solution Data Report > Rectagular Plot 

3- Pour voir et vérifier les paramètres d’antenne : dans la fenêtre « Project manager 

window >  clic droit sur Radiation > Infinites sphere > Compute antenna parameters > 

Solutiont  (-180°<deta<180°, step : 02) 

4- En 3d : Dans la fenêtre « Project manager window >  clic droit sur Results > radiation 

patern. 
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V. Les diagrammes de rayonnement de l’antenne 

A partir de la conception faite, tracer les diagrammes demandés ci-dessous : 

a.    Le paramètre S11                                                                                                                             

 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

 

b.    Le diagramme de rayonnement dans le plan V 
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c.  Le diagramme de rayonnement dans le plan H 

 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

 

d.    Le diagramme de rayonnement dans l’espace 
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VI. Questions 

À partir des simulations faites, répondre aux questions suivantes : 

 

1. Bande de résonnance : Tracer sur le diagramme, la bande de fréquence de cette antenne. 

 

a- Directivité : 

b- Tracer l’angle (𝜽−𝟑𝒅𝑩) sur le diagramme, et calculer sa valeur. 

c- Décrire la directivité de cette antenne. 

 

 

 

d- Quel est le type de cette antenne ? 

 

 

2. Remplir le tableau suivant :  

 

Paramètre S11 
Fc 

(GHz) 

Bp 

(GHz) 
λ (m) 

Longueur 

du dipôle 
𝜃−3𝑑𝐵  Gmax 

Nbre lobes 

principaux 

Nbre lobes 

secondaires 

Valeur …… ……… ……… ……… ……… ……… ……… ……… ……… 

 

3. Changement de la longueur de l’antenne : Changer la longueur du dipôle par l’ajout de 

‘lambda/4’ à la longueur initiale « len_dip ». Remplir le tableau ci-dessous : 

 

 Remarques & Conclusions ? 

1- ..................................................................................................................................................................... 

2- ..................................................................................................................................................................... 

3- ............................................................................................................................................................. 

Paramètre S11
’
 

Fc
’
 

(GHz) 

Bp 
’
 

(GHz) 
λ (m) 

Longueur 

dipôle
’
 

𝜃−3𝑑𝐵
’
 Gmax

’
 

Nbre lobes 

principaux 

Nbre lobes 

secondaires 

Valeur …… ……… ……… ……… ……… ……… ……… ……… ……… 
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Simulation de l’antenne 

Monopole 

 

 

Introduction 

Dans cette séance de travaux pratiques, nous allons concevoir une antenne monopole par le 

simulateur HFSS en utilisant les paramètres donnés ci-dessous.  

 L’objectif est de visualiser les différentes caractéristiques et performances de cette 

antenne. 

 

 Définition 

L’antenne monopole est inventée en 1895 par Gugliemo. Elle se compose d’une tige (file) 

placée sur un plan conducteur, et alimentée par son extrémité connecté au plan de masse. La 

distribution du courant sur ce brin ressemble à celle sur l’un des brins du dipôle. L’effet image 

est assuré par le plan de masse, ce qui contribue au rayonnement de cette antenne. L’antenne 

monopole la plus connue est l’antenne quart d’onde de longueur égale au quart d’onde, placée 

sur un plan conducteur, qui rend son comportement presque similaire à celui d’un dipôle, il est 

appelé aussi antenne Marconi. 

 

Fig 1.11 Antenne monopôle (quart d’onde). 

TP1 : Expérience 3 
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 Domaines d’application  

Le dipôle est appliqué dans la radiodiffusion en bande VHF et UHF par l’antenne de type 

Fouet. L’antenne monopole est souvent appliquée sur les toits des voitures ou avions qui servent 

comme un plan de masse à l’antenne. Le monopole quart est beaucoup utilisé dans les téléphones 

mobiles et les terminaux dans les réseaux WLAN. [2]  

 

I. Conception et simulation de l’antenne 

Pour la création et la conception de l’antenne Dipôle; nous allons considérer les valeurs et les 

dimensions suivantes : 

Paramètre 
Symbole 

utilisé 
Valeur Unité 

Fréquence de coupure Fo 1 () GHz 

Célérité de la lumière  Co 3.10
8
 m/s 

Longueur d’onde lamda Co/Fo mm 

Rayon du Monopole rad_mpol lamda/4/60 mm 

Rayon du plan de mass rad_plan rad_mpol+(lamda/4) mm 

Source d’alimentation gap_feed rad_mpol*2 mm 

Longueur du monopôle len_mpol (lamda/4)-gap_feed mm 

Cylindre des mesures mes_hi gap_feed+len_mpol+(lamda/2) mm 

Table 1.2 Dimensions pour la conception du monopôle. 

 

 Note: Vous gardez ce tableau pour l’utiliser durant la conception et la simulation de l’antenne. 

 

II. Conception de l’antenne 

Pour concevoir l’antenne et l’environnement de mesures ; vous suivez les étapes suivantes : 
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1- Dans la barre d’outils, sélectionner File > New, et un nouveau projet apparait dans la fenêtre 

« Project manager », 

2-  Dans la barre d’outils, sélectionner Tools > Options > General options > Default Units > 

Length :  « mm », 

3- Dans la barre d’outils, sélectionner Tools > Options > General options > Default Units > 

Frequency :  « GHz », 

4- Dans la barre d’outils, sélectionner Project > Insert HFSS design, 

5- Dans la barre d’outils, sélectionner Project > Save as : Monopole-antenna, 

6- Dans la barre d’outils, sélectionner HFSS > Design Properties > add : ajouter tous les 

paramètres d’entrée donnés dans le tableau mentionné ci-dessus, 

7-  Pour tracer la première partie de l’antenne, on trace un cylindre. Pour 

cela dans la barre d’outils, appuyer sur « Draw cylindre », et dessiner le 

cylindre. Une fenêtre du cylindre apparait à gauche. 

8- Dans cette fenêtre, fait un double clic sur « Cylinder1», et modifier le nom et le matériel : > 

Name : monopole, et  

                 > Material > edit > pec. 

9- Dans la même fenêtre : > double clic sur « CreateCylinder», et mettre les dimensions 

suivantes : 

> Centre : 0 , 0 , gap_feed, 

> Radius : rad_mpol, 

> Height : len_mpol, 

 

10- Pour créer le plan de masse, Dans la barre d’outils, appuyer sur « Draw circle», et dessiner 

le cylindre. Il va apparaitre dans la fenêtre à gauche. 

11- double clic sur « Circle1» > Name : Plan, 

12- Dans la même fenêtre : > double clic sur « CreateCirle1», avec : 

> Centre : 0 , 0 , 0 

> Axis : Z, 

> Radius : rad_plan, 

13- Pour définir le Plan comme une surface de masse : > clic droit sur « Plan » > Assign 

Boundary > Perfect E > cocher « infinite Ground Plane ». 
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14- Pour tracer la source d’alimentation (Fed) ; dans la barre d’outils, appuyer sur « Draw 

ractangle ». Dessiner le rectangle. 

15- Dans la fenêtre à gauche, > double clic sur « Rectangle1», et modifier le nom :  

> Name : Fed. 

16- Dans la même fenêtre : > double clic sur « Createrectangle», et mettre 

les dimensions suivantes : 

> Axis : X, 

> Y size : gap_feed, 

> Z size : gap_feed, 

17- Pour spécifier le type d’excitation de l’alimentation : > clic droit sur 

« Fed » > Assign Exitation > Lumped Port > Name :1 , Resistance: 75 

> Clic Next > Integration line > New line > Defined > Clic Next > Do 

Not Renomalize > Finish.  

 

III. Mesures des caractéristiques 

Pour tracer les mesures sur les performances de l’antenne, on doit définir la surface où on veut 

prendre les mesures. 

1- Dans la barre d’outils, appuyer sur « Draw cylindre », et dessiner le cylindre. Il va apparaitre 

dans la fenêtre à gauche. 

2- double clic sur « Cylinder1» > Name : Mesure_surface, 

> Color : Vert, 

> Transparent : 0.7. 

3- Dans la même fenêtre : > double clic sur « CreateCylinder», avec : 

> Centre : 0 , 0 , - lamda/4 

> Axis : Z, 

> Radius : rad_plan, 

> Height : mes_hi, 

4- Pour définir le cylindre comme une surface de mesure : > clic droit sur 

« Mesure_surface » > Assign Boundary > Radiation > Radiation only > ok. 

5- Dans la fenêtre la plus à gauche (Project manager window) : > clic droit sur « Analysis » > 

Add solution setup : 
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> Solution frequency : 1 GHz, 

> Maximum number of passes : 20, 

6- Dans la fenêtre la plus à gauche (Project manager window) : >  Analysis» > Setup1 > add 

frequency sweep : 

> Sweep Type : Fast, 

> Frequency setup: > Type : LinearCount, 

>  Start : 0.5 GHz, 

> Stop : 1.5 GHz, 

> Count : 101, 

 

7- Pour vérifier que la simulation est complète et la 

programmation et les données introduises sont 

justes, on fait : Dans la barre d’outils, appuyer sur 

Validate. Si la fenêtre ne montre pas des erreurs, 

alors la conception est complète. 

 

 

IV. La simulation des performances (Résultats) 

 

5- Dans la barre d’outils, cliquer sur « Analyze all » .   

 Si la conception ne porte pas des erreurs et si les données introduises sont valides, alors une 

fenêtre en bas affiche le message « Normal Completion of simulation». Comme le montre la 

figure ci-dessous. 

 

Fig 1.12 Simulation vérifiée et validée. 

 

6- Dans la fenêtre la plus à gauche (Project manager window) : >  clic droit sur Results > 

Creat Model Solution Data Report > Rectagular Plot 
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7- Pour voir et vérifier les paramètres d’antenne : dans la fenêtre « Project manager 

window >  clic droit sur Radiation > Infinites sphere > Compute antenna parameters > 

Solutiont  (-180°<deta<180°, step : 02) 

8- En 3d : Dans la fenêtre « Project manager window >  clic droit sur Results > radiation 

patern. 

 

VII. Les diagrammes de rayonnement de l’antenne 

A partir de la conception faite, tracer les diagrammes demandés ci-dessous : 

a. Le paramètre S11                                                                                                                             

 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

b. Le diagramme de rayonnement dans le plan V 
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   Le diagramme de rayonnement dans le plan H 

 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

 

c.    Le diagramme de rayonnement dans l’espace 
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VIII. Questions 

A partir des simulations faites, répondre aux questions suivantes : 

 

1. Bande de résonnance : Tracer sur le diagramme, la bande de fréquence de cette antenne. 

 

2. Directivité : 

e- Tracer l’angle (𝜽−𝟑𝒅𝑩) sur le diagramme, et calculer sa valeur. 

f- Décrire la directivité de cette antenne. 

 

 

 

g- Quel est le type de cette antenne ? 

 

 

 

3. Remplir le tableau suivant :  

 

Paramètre S11 
Fc 

(GHz) 

Bp 

(GHz) 
λ (m) 

Longueur 

du dipôle 
𝜃−3𝑑𝐵  Gmax 

Nbre lobes 

principaux 

Nbre lobes 

secondaires 

Valeur …… ……… ……… ……… ……… ……… ……… ……… ……… 

 

4. Changement de la longueur de l’antenne : Changer la longueur du dipôle par l’ajout de 

‘lambda/4’ à la longueur initiale « len_dip ». Remplir le tableau ci-dessous : 

 

 Remarques & Conclusions ? 

1- ...............................................................................................................................................................

.................................. 

2- ............................................................................................................................................................... 

Paramètre S11
’
 

Fc
’
 

(GHz) 

Bp 
’
 

(GHz) 
λ (m) 

Longueur 

dipôle
’
 

𝜃−3𝑑𝐵
’
 Gmax

’
 

Nbre lobes 

principaux 

Nbre lobes 

secondaires 

Valeur …… ……… ……… ……… ……… ……… ……… ……… ……… 
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Expériences du TP2 Sujet de l’expérience Durée 

Expérience 1 Les antennes : dipôle et monopole 1h30 

Expérience 2 Les antennes : Cornet et Yagi 1h30 

Expérience 3 Les antennes : Single patch et Patch Array 1h30 

 

: TP2 

Mesures d’antennes 

(03 expériences)
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 Présentation du TP2 :  

Le TP2 consiste à faire des mesures sur des différents types d’antenne disponibles au 

niveau de notre laboratoire de télécommunication. A travers ce TP l’étudiant peut avoir une 

maitrise sur les caractéristiques de ces antennes ainsi que d’autres techniques de mise en service, 

installation et correction des liaisons radio. 

 

 Déroulement du TP: 

Le TP2 comprend plusieurs expériences dont chacune, l’étudiant doit installer une nouvelle 

antenne pour établir une liaison hertzienne et faire les mesures et calcules nécessaires dans 

chaque expérience. 

 

 Objectif du TP2 : Nous résumons les objectifs de ce TP dans les points suivants : 

 S’introduire aux liaisons hertziennes, 

 Pratiquer l’installation et l’alignement de plusieurs types d’antennes, 

 Etudier les radiations des antennes avec différentes polarisations, 

 Mesurer les gains des antennes et leurs radiations, 

 Tester les interférences entre les liens.  

 

 Le kit de l’expérience :  

Les expériences dans ce TP, s’achèvent à base d’une liaison hertzienne qui s’établit sur un kit de 

transmission composé des équipements suivants : 

 Main controller (Unité principale de contrôle) :   Est une unité essentiel pour contrôler 

les deux stations d’émission et de réception (Figure 2.1). Elle porte les caractéristiques 

suivantes : 

 Bandes de fréquences : 500MHz, 2GHZ et 10GHz 

 Puissance : 10mw 

 Impédance de sortie : 50ohms  

 Fréquence de modulation : 1KHz. 

 Niveau du signal reçu : -50dBm à -10dBm 

 Rotation de l’antenne : 0° à 360°, 

 Le pas de rotation : 1°, 5°, 10°. 
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Fig 2.1 Unité principale de contrôle. 

 

 Transmetteur : Est une unité d’émission, reliée au Main controller par un câble coaxial. 

Elle porte une règle et un support pour aligner, changer la polarisation (verticale ou 

horizontale) et bien fixer l’antenne de réception (Figure 2.2).     

 

Fig 2.2 Transmetteur. 

 Récepteur : Est une unité de réception, reliée aussi au Main controller par un câble 

coaxial. Elle porte une règle et un support pour aligner, changer la polarisation (verticale 

ou horizontale) et bien fixer l’antenne de réception (Figure 2.3).  
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Fig 2.3 Récepteur. 

 

 

  Remarque : La polarisation de l’antenne dépond de son mode d’alimentation en référence au 

sol, ei : Si l’antenne est alimentée horizontalement par rapport au sol, alors l’antenne dans ce 

cas-là est polarisée horizontalement. Et de même, si l’antenne est alimentée verticalement par 

rapport au sol, alors l’antenne dans ce cas-là est polarisée verticalement. 

 

    Prérequis nécessaires :  

Pour le bon déroulement des séances du TP2, l’étudiant doit : 

 Connaitre les notions fondamentales sur les liaisons hertziennes, 

 Connaitre les notions fondamentales sur les antennes, 

 Maitriser les différentes caractéristiques des antennes : Dipole, monopole, Yagi, Cornet et 

l’antenne patch, 
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 Outils nécessaires :  

 Un microordinateur, RAM (4Go), 

 Windows 7 x64 (minimum).                Disponibles au laboratoire télécom. 

 Logiciel Antenna trainer installé, 

 Station d’émission et de réception, 

 Un mètre,                                                  Disponibles au laboratoire télécom. 

 Clé USB pour sauvegarder les résultats obtenus,  

 Papiers millimétriques,             fournit par l’étudiant. 

 Outils de dessin et de mesures (crayon, règle, gomme,…). 

 

 

 Rapport du TP : A l’issue du TP, chaque équipe (binôme) est demandée de déposer durant la 

semaine, un rapport contenant les réponses demandées. 

 

 

Fig 2.4 Kit de mesure [3]. 
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 Etapes de l’expérience :  

1- Préparation du lien radio avec l’antenne Dipôle, 

2- Mesure de rayonnement en polarisation verticale, 

3- Mesure de rayonnement en polarisation horizontale, 

4- Répondre aux questions demandées à la fin de la brochure du TP, 

5- Répéter les étapes 1 à 4 avec l’antenne Monopole.  

 

 

I. Partie 1 : L’antenne Dipôle 

 

I.1. Préparation du lien radio 

Avant de commencer l’expérience, vous devez établir la liaison radio sur laquelle l’antenne sujet 

de l’étude (dipôle, Monopole) est installée en récepteur. Pour cela, vous suivrez les étapes 

suivantes :  

a. Mettre ‘ Off ‘ le Main controller, 

b. Mettre ‘ Off ‘ les bottons de la modulation et de la fréquence sur le Main controller, 

c. Allumer le Pc, et Relier le Main controller au PC via le port USB. 

d. Relier le Main controller au transmetteur (Transmitter station), 

e. Relier le Main controller au récepteur (Receiver station), 

f. Installer l’antenne ‘ Yagi ‘ sur la barre stationnaire de l’émetteur, 

g. Installer l’antenne ‘ Dipôle 500 MHz’ sur la barre stationnaire du récepteur, 

h. Assurer une distance de séparation (lien) de 1.5m entre les deux antennes, 

i. Assurer un bon alignement du lien,   
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j. Connecter l’antenne Yagi et le Main controller via le port : Oscillation output terminal, 

par le câble SMA 2m. 

k. Connecter l’antenne Dipôle et la station récepteur via le port : RF IN terminal, par le 

câble SMA 1m. 

l. Confirmer le bon serrage de toutes les connexions faites (antenne-coax, coax-Main 

controller, Main controller-Pc, …). 

 

Fig 2.5 Lien dipole-Yagi [3]. 

 

I.2. Rayonnement en polarisation horizontale 

Mettre les deux antennes Yagi et Dipôle en polarisation horizontale et fais :  

a. Allumer le Main controller,  

b. Allumer le bouton Switch 500 MHz dans la Main controller, 

c. Activer la modulation dans la Main controller, 

d. Lancer l’application « Antenna trainer » en choisissant le port de communication qui 

convient (com1-4), 

e. Si la fenêtre ci-dessous apparaitra, sélectionner le type d’antenne ‘Dipôle 500 MHz’,  

f. Sélectionner le plan E (E-plane) pour visualiser le diagramme de rayonnement, 

g. Ajuster l’atténuation (Reduction) afin d’avoir le plus faible gain d’antenne (0dB), 

h. Cliquer sur le bouton ‘Auto’ pour commencer l’acquisition des données,  

i. Terminer l’acquisition des données, 

j. Sauvegarder les diagrammes obtenus. 
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Fig 2.6 L’application « Antenna trainer » pour l’acquisition des données. 

 

I.3. Rayonnement en polarisation verticale 

Mettre les deux antennes Yagi et Dipôle en polarisation horizontale et fais :  

 Réinitialiser les antennes, 

 Sélectionner le plan H (H-Plane),  

 Répéter les mêmes étapes (g, h, i et j) de la polarisation horizontale. 
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I.4. Questions 

Répondre aux questions suivantes : 

a. C’est quoi une antenne ?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . 

b. Définir une antenne isotrope, et c’est quoi son intérêt ? : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . 

c. Définir l’antenne dipôle : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . 

d. Donner quelques exemples réels de l’application de l’antenne dipôle : ― . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . ., ―  . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . , ― . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . 

e.  Tracer le diagramme dans le plan E : 
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f. Tracer le diagramme dans le plan H : 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

g. Remplir le tableau ci-dessous : 

         Angle (°) 

Pr(dB) …... 
0 30 60 90 120 150 180 210 240 270 300 330 

E-plane . . . .   . . . .  . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

H-plane . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 

h. Tracer l’angle 𝜽−𝟑𝒅𝑩 . Donner vos remarques (directivité) : . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . 

i. Remplir le tableau ci-dessous : 

F (freq) λ T D 
Longueur 

antenne 

Type 

antenne 
Pr max 𝜽−𝟑𝒅𝑩 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . 

 

j. Exprimer l’équation de Friis du lien établit (Utiliser Pr-max) en définissant les différents 

facteurs de l’équation: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

k. Décrire les différences en rayonnement entre les deux polarisations : . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . .  

 

l. Maintenant, augmenter légèrement la longueur du dipôle (5mm), et mesurer le rayonnement 

(répéter l’expérience). Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . 
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II. Partie 2: L’antenne Monopôle (Grounding antenna) 

 

II.1. Préparation du lien radio 

a. Mettre ‘ Off ‘ le Main controller, 

b. Mettre ‘ Off ‘ les bottons de la modulation et de la fréquence sur le Main controller, 

c. Laisser l’antenne ‘ Yagi ‘ sur la barre stationnaire de l’émetteur, 

d. Désinstaller le dipôle, 

e. Installer l’antenne ‘ Monopôle 500 MHz’ à la place du dipôle, 

f. Assurer une distance de séparation (lien) de 1.5m entre les deux antennes, 

g. Assurer un bon alignement du lien, 

h. Confirmer le bon serrage de toutes les connexions faites (antenne-coax, coax-Main 

controller, Main controller-Pc, …). 

 

Fig 2.7 Lien Monopole-Yagi [3]. 

 

II.2. Rayonnement en polarisation horizontale  

Mettre les deux antennes Yagi et Monopôle en polarisation horizontale et fais :  

a. Allumer le Main controller,  

b. Allumer le bouton Switch 500 MHz dans la Main controller, 

c. Activer la modulation dans la Main controller, 

d. Lancer l’application « Antenna trainer » en choisissant le port de communication qui 

convient (com1-4), 

e. Sélectionner le type d’antenne ‘Monopôle 500 MHz’,  

f. Sélectionner le plan E (E-plane) pour visualiser le diagramme de rayonnement, 

g. Ajuster l’atténuation (Réduction) afin d’avoir le plus faible gain d’antenne (0dB), 
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h. Cliquer sur le bouton ‘Auto’ pour commencer l’acquisition des données,  

i. Terminer l’acquisition des données, 

j. Sauvegarder les diagrammes obtenus. 

 

II.3. Rayonnement en polarisation verticale 

Mettre les deux antennes Yagi et Monopôle en polarisation horizontale et fais :  

 Réinitialiser les antennes, 

 Sélectionner le plan H (H-Plane),  

 Répéter les mêmes étapes (q, r, s et t) de la polarisation horizontale. 
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II.4.  Questions 

  Répondre aux questions suivantes : 

a. Définir l’antenne Monopôle : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . 

b. Donner quelques exemples réels de l’application de l’antenne Monopôle : ― . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . ., ―  . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . , ― . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . 

c. Tracer le diagramme dans le plan E : 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

d. Tracer le diagramme dans le plan H : 
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e. Remplir le tableau ci-dessous : 

         Angle (°) 

Pr(dB) …... 
0 30 60 90 120 150 180 210 240 270 300 330 

E-plane . . . .   . . . .  . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

H-plane . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 

f. Tracer l’angle 𝜽−𝟑𝒅𝑩 . Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . 

g. Remplir le tableau ci-dessous : 

F (freq) λ T D 
Longueur 

antenne 

Type 

antenne 
Pr max 𝜽−𝟑𝒅𝑩 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . 

 

h. Décrire les différences en rayonnement entre les deux polarisations : . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . .  

 

i. Maintenant, augmenter légèrement la longueur du dipôle (5mm), et mesurer le rayonnement 

(répéter l’expérience). Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . 
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 Etapes de l’expérience :  

1- Préparation du lien radio avec l’antenne Yagi, 

2- Mesure de rayonnement en polarisation verticale, 

3- Mesure de rayonnement en polarisation horizontale, 

4- Répondre aux questions demandées à la fin de la brochure du TP, 

5- Répéter les étapes 1 à 4 avec l’antenne Cornet.  

 

 

I. Partie 1 : L’antenne Yagi (Râteau) 

 

 

Fig 2.8 Les éléments d l’antenne Yagi [3]. 

 

I.1. Préparation du lien radio 

 Répéter soigneusement et respectivement les mêmes étapes pour la préparation du lien de 

l’expérience précédente.  

 Mettre une deuxième antenne Yagi 500MHz comme récepteur. 
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Fig 2.9 Lien Yagi-Yagi [3]. 

 

I.2. Rayonnement en polarisation horizontale 

Mettre les deux antennes Yagi en polarisation horizontale. 

a. Sélectionner l’antenne Yagi500MHz dans l’application ‘Antenna trainer’, 

b. Commencer l’acquisition auto des données,  

c. Terminer l’acquisition des données, 

d. Sauvegarder les diagrammes obtenus. 

 

I.3. Rayonnement en polarisation verticale  

Mettre les deux antennes Yagi en polarisation horizontale et répéter l’expérience en choisissant 

le plan H (H-Plane). 
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I.4. Questions 

Répondre aux questions suivantes : 

a. Définir l’antenne Yagi : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . 

b. Donner quelques exemples réels de l’application de l’antenne Yagi : ― . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . ., ―  . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . , ― . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . 

c.  Tracer le diagramme dans le plan E : 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

d. Tracer le diagramme dans le plan H : 
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e. Remplir le tableau ci-dessous : 

         Angle (°) 

Pr(dB) …... 
0 30 60 90 120 150 180 210 240 270 300 330 

E-plane . . . .   . . . .  . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

H-plane . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 

 

f. Tracer l’angle 𝜽−𝟑𝒅𝑩 . Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . 

 

g. Remplir le tableau ci-dessous : 

F λ D L1 L2 L3 L4 L5 D1 D2 D3 D4 D5 
Pr 

max 
𝜽−𝟑𝒅𝑩 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 

 

h. Exprimer l’équation de Friis du lien établit (Utiliser Pr-max) en définissant les différents 

facteurs de l’équation: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

 

i. Décrire les différences en rayonnement entre les deux polarisations : . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . .  
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j. Maintenant, Enlever respectivement les éléments L1, L2 et L3. Relancer à chaque fois la 

mesure et taper les valeurs suivantes : 

 

 

           Grandeur 

Elément  

supprimé 

Pr_max 
Angle  

(Pr_max) 
𝜽−𝟑𝒅𝑩 

L1 . . . . . . . . . 

L2 . . . . . . . . . 

L3 . . . . . . . . . 

 

 

k. Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

………………………………………………………………………………………………  
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II. Partie 2 : L’antenne Cornet (Horn antenna) 

 

 

Fig 2.10 Les dimensions de l’antenne Cornet [3]. 

 

L’expression du gain est donnée par la relation [3]: 

 

II.1. Préparation du lien radio 

 Mettre ‘ Off ‘ le Main controller, 

 Mettre ‘ Off ‘ les bottons de la modulation et de la fréquence sur le Main controller, 

 Etablir un lien entre deux antennes Cornets 10GHz. 

 

Fig 2.11 Lien Cornet-Cornet [3]. 

II.2. Rayonnement en polarisation horizontale  

Mettre les deux antennes Cornet en polarisation horizontale. 

a. Sélectionner l’antenne Horn 10 GHz dans l’application ‘Antenna trainer’, 

b. Commencer l’acquisition auto des données,  

c. Terminer l’acquisition des données et sauvegarder les diagrammes obtenus. 

 

II.3. Rayonnement en polarisation verticale 

Mettre les deux antennes cornets ‘Horn’ en polarisation horizontale et répéter l’expérience en 

choisissant le plan H (H-Plane). 
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II.4. Questions 

Répondre aux questions suivantes : 

a. Définir l’antenne Cornet (Horn antenna) : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . 

b. Donner quelques exemples réels de l’application de l’antenne Cornet : ― . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . ., ―  . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . , ― . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . 

c. Tracer le diagramme dans le plan E : 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

d. Tracer le diagramme dans le plan H : 
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e. Remplir le tableau ci-dessous : 

         Angle (°) 

Pr(dB) …... 
0 30 60 90 120 150 180 210 240 270 300 330 

E-plane . . . .   . . . .  . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

H-plane . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 

f. Tracer l’angle 𝜽−𝟑𝒅𝑩 . Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . 

g. Remplir le tableau ci-dessous : 

F 

(freq) 
λ D a b A B LE RE LH RH Pr max 𝜽−𝟑𝒅𝑩 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 

h. Exprimer l’équation de Friis du lien établit (Utiliser Pr-max) en définissant les différents 

facteurs de l’équation: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . 

i. Décrire les différences en rayonnement entre les deux polarisations : . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . .  

j. Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . .  
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 Etapes de l’expérience :  

1- Préparation du lien radio avec l’antenne Single Patch, 

2- Mesure de rayonnement en polarisation verticale, 

3- Mesure de rayonnement en polarisation horizontale, 

4- Répondre aux questions demandées à la fin de la brochure du TP, 

5- Répéter les étapes 1 à 4 avec l’antenne Array.  

 

 

I. Partie1 : L’antenne Single Patch 

 

Fig 2.12 L’antenne single Patch [3]. 

 

I.1. Préparation du lien radio  

 Répéter soigneusement et respectivement les mêmes étapes pour la préparation du lien 

dans les expériences précédentes.  

 Mettre une deuxième antenne Cornet 10GHz comme récepteur. 

 Aligner le centre du Cornet au centre du single patch (Figure 2.13). 
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Fig 2.13 Lien Single patch-Cornet [3]. 

 

I.2. Rayonnement en polarisation horizontale  

Mettre les deux antennes en polarisation horizontale. 

a. Sélectionner l’antenne Single patch 10GHz dans l’application ‘Antenna trainer’, 

b. Commencer l’acquisition auto des données,  

c. Terminer l’acquisition des données, 

d. Sauvegarder les diagrammes obtenus. 

 

I.3. Rayonnement en polarisation verticale 

Mettre les deux antennes en polarisation horizontale et répéter l’expérience en choisissant le plan 

H (H-Plane). 
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I.4. Questions 

Répondre aux questions suivantes : 

a. Définir l’antenne Single patch : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . 

b. Donner quelques exemples réel de l’application de l’antenne Single patch : ― . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . ., ―  . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . , ― . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . 

c. Tracer le diagramme dans le plan E : 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

d. Tracer le diagramme dans le plan H : 
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e. Remplir le tableau ci-dessous : 

         Angle (°) 

Pr(dB) …... 
0 30 60 90 120 150 180 210 240 270 300 330 

E-plane . . . .   . . . .  . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

H-plane . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 

f. Tracer l’angle 𝜽−𝟑𝒅𝑩 . Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . 

g. Remplir le tableau ci-dessous : 

F (freq) λ T D 
Longueur 

antenne 

Type 

antenne 
Pr max 𝜽−𝟑𝒅𝑩 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . 

 

h. Exprimer l’équation de Friis du lien établit (Utiliser Pr-max) en définissant les différents 

facteurs de l’équation: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

i. Décrire les différences en rayonnement entre les deux polarisations : . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

j. Comparer le rayonnement de l’antenne single patch à celui de l’antenne Cornet :                     . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

k. Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . 
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II. Partie 2 : L’antenne Patch Array 

 

 

Fig 2.14 L’antenne Patch Array [3]. 

 

II.1. Préparation du lien radio 

 Mettre ‘ Off ‘ le Main controller, 

 Mettre ‘ Off ‘ les bottons de la modulation et de la fréquence sur le Main controller, 

 Etablir un lien entre l’antenne Patch Array et l’antenne Cornet 10GHz. 

 

Fig 2.15 Lien Patch Array-Cornet [3]. 

 

II.2. Rayonnement en polarisation horizontale  

Mettre les deux antennes en polarisation horizontale. 

a. Sélectionner l’antenne Horn 10 GHz dans l’application ‘Antenna trainer’, 

b. Commencer l’acquisition auto des données,  

c. Terminer l’acquisition des données, et sauvegarder les diagrammes obtenus 

 

II.3. Rayonnement en polarisation verticale 

Mettre les deux antennes en polarisation horizontale et répéter l’expérience en choisissant le plan 

H (H-Plane). 
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II.4. Questions 

Répondre aux questions suivantes : 

a. Définir l’antenne Patch Array : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . 

b. Donner quelques exemples réels de l’application de l’antenne Patch Array : ― . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . ., ―  . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . , ― . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . 

c. Tracer le diagramme dans le plan E : 

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

                    

 

d. Tracer le diagramme dans le plan H : 
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e. Remplir le tableau ci-dessous : 

         Angle (°) 

Pr(dB) …... 
0 30 60 90 120 150 180 210 240 270 300 330 

E-plane . . . .   . . . .  . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

H-plane . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 

f. Tracer l’angle 𝜽−𝟑𝒅𝑩 . Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . 

g. Remplir le tableau ci-dessous : 

F (freq) λ T D 
Longueur 

antenne 

Type 

antenne 
Pr max 𝜽−𝟑𝒅𝑩 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . 

 

h. Exprimer l’équation de Friis du lien établit (Utiliser Pr-max) en définissant les différents 

facteurs de l’équation: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

i. Décrire les différences en rayonnement entre les deux polarisations : . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . .  

j. Comparer le rayonnement du Patch Array à celui de l’antenne Single Array : . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . .  

k. Donner vos remarques : . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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 TP01/ Exp 02 : Dipôle de hertz 
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 TP01/ Exp 03 : L’antenne monopole 
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 TP02/ Exp 01 / part 1: L’antenne dipôle 
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 TP02/ Exp 01 / part 2: L’antenne monopôle 
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 TP02/ Exp 01 / part 2: L’antenne Cornet 
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